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Abstract

We deal with the problem of zero-shot cross-modal image

retrieval involving color and sketch images through a novel

deep representation learning technique. The problem of a

sketch to image retrieval and vice-versa is of practical im-

portance, and a trained model in this respect is expected

to generalize beyond the training classes, e.g., the zero-

shot learning scenario. Nonetheless, considering the dras-

tic distributions-gap between both the modalities, a fea-

ture alignment is necessary to learn a shared feature space

where retrieval can efficiently be carried out. Additionally,

it should also be guaranteed that the shared space is se-

mantically meaningful to aid in the zero-shot retrieval task.

The very few existing techniques for zero-shot sketch-RGB

image retrieval extend the deep generative models for learn-

ing the embedding space; however, training a typical GAN

like model for multi-modal image data may be non-trivial

at times. To this end, we propose a multi-stream encoder-

decoder model that simultaneously ensures improved map-

ping between the RGB and sketch image spaces and high

discrimination in the shared semantics-driven encoded fea-

ture space. Further, it is guaranteed that the class topology

of the original semantic space is preserved in the encoded

feature space, which subsequently reduces the model bias

towards the training classes. Experimental results obtained

on the benchmark Sketchy and TU-Berlin datasets estab-

lish the efficacy of our model as we outperform the existing

state-of-the-art techniques by a considerable margin.

1. Introduction

Research has been at its best in the last few years due

to the advancement in high-computing technologies and the

accumulation of very large scale data. This is also partly due

to improved technologies for cost-effective and vast multi-

tudes of varieties of sensors. Due to this, the same data

can be described in different formats and representations.

Since each of these representations often encompasses the

features from the same object, inter-modal data retrieval be-

tween these representations finds a huge application. This

is because a few forms of data representation could be more

informative than the others, while some might be more vi-

sualizable for better understanding.

One such minimalistic representation of visual data is

in the form of sketches. With the availability of cheap

styluses, drawing quick sketches can be made in the nick

of time. Sketch-based image retrieval (SBIR) finds nu-

merous applications nowadays in forensic studies for po-

lice investigations made using criminal sketch queries. In

SBIR, we query a sketch and retrieve corresponding nearest

k neighbors from a large-scale image database. This idea

can be extended to make a cross-modal retrieval framework;

wherein one can incorporate both SBIR and IBSR (image-

based sketch retrieval). However, it can be noted that since

sketches lack texture information, learning using CNNs be-

come extremely difficult as CNNs have been seen to have an

inherent bias towards learning from the image textures [9].

Hence, SBIR and IBSR are challenging problems that are

highly researched upon in recent times.

Out of the few limited works that have been dome in

cross-modal retrieval (CMR), only a few have worked on

zero-shot learning (ZSL) based CMR. A few notable works

in ZSL based SBIR have started coming up recently. The

idea of ZSL is to train a network for a select number of

training classes seen classes for which the training samples

are available, along with its class attribute information. The

aim is to train the network so well that while testing if we

provide an entirely new and non-overlapping class or un-

seen class data samples along with its attribute information,



the network should be able to classify it into that class cor-

rectly. The difficulty level shoots up when we deploy such

a framework for a CMR architecture.

Most of the works in SBIR, which are done nowadays,

use generative models. This is done by creating pseudo

samples of unseen classes using their semantic informa-

tion by incorporating discriminator and generator functions.

However, the main problem with this type of work is, it is

often challenging to train a stable network. This can hap-

pen if the derived feature space is not particularly suffi-

ciently discriminative enough. This is difficult in sketches

as sketches are a minimalistic representation of data and can

be easily confused withing various classes. Some of the

prominent works using generative networks are [21, 11].

Our contributions: Taking into account the problems as

mentioned earlier and the gap in the literature, we propose a

very simple yet novel zero-shot based cross-modal retrieval

of sketch images. While the existing literature only focuses

on retrieving the SBIR part, we make our network robust

for both SBIR and IBSR problems. Single way network is

easier to train as we address only half of the complete prob-

lem statement. The moment we encode the IBSR part to

the model, the performance of the SBIR is partially com-

promised. Hence, the network is designed in such a way

to provide maximum SBIR and IBSR performances. Our

main contributions in this work are:

1) We use a cross-modal retrieval framework by con-

structing a shared discriminative embedding space for the

data instances of different modalities. 2) We use a cross-

reconstruction network to bridge the domain gap between

the different modalities. 3) A cross-triplet loss for increas-

ing the intra-class distance in the feature space, while reduc-

ing the inter-modal distance. 4) We extend the network for

a zero-shot based CMR. 5) We experiment with the perfor-

mance of the proposed model on the standard benchmarked

large-scale databases, i.e., TU-Berlin and Sketchy, and ob-

tain superior performance than the current state-of-the-art

models. It is a reasonably easy model and very quickly

trained.

2. Related Works

In this section, we discuss the main works in literature

that have relevance in our domain. The literature survey

part mainly comprises of CMR and ZSL in SBIR.

Few of the notable early works in the field of retrieval

was mainly done by [6, 8]. These were non-learning based

retrieval frameworks from a single modality of data. Soon

with the popularity in learning-based techniques, many

more works started coming up using pre-trained networks,

like Resnet, GoogleNet, VggNets, etc. [22, 4, 2]. With

the introduction to learning-based techniques and the accu-

mulation of unprecedented volumes of data from different

sensors, researchers started focusing more on cross-modal

retrieval techniques. Some of the notable CMR works in

literature are mostly image and text pair CMR, which has

been quite extensively researched upon [16]. CMR also

finds essential applications in RGB image to depth estima-

tion in computer vision, SLAM problems, and depth estima-

tion from LiDAR point clouds [23]. Some works have also

been done on image and speech pair retrieval [3]. Recently,

with the advancement in touch and sensor technology, peo-

ple have been researching on sketch-based image retrieval

problems (SBIR). However, the present work done in litera-

ture does not involve a cross-modal retrieval, rather a single

way retrieval framework only [27, 29, 25, 12].

ZSL framework uses the concept of making a model

learn from a set of seen classes. The idea is to make the

model learn so well that on deployment, it can recognize

even unseen classes (which is a disjoint set of classes from

the seen class set). A detailed review of the literature in

zero-shot has been provided in [7]. A conspicuous early

work in ZSL was by [1], after which researches on ZSL

gained acceleration. For associating the class features from

one set of classes to their corresponding class label, we

use a class-descriptive attribute or semantic information.

The semantic information can be deployed in many ways.

Few researchers have used visual semantic mappings [10],

while some have used word2vec embeddings of the class la-

bels [5], on the other hand, some used a complete sentence

description of the image captions [19]. Most of the works

in ZSL, which are done nowadays, use generative models.

This is done by creating pseudo samples of unseen classes

using their semantic information, by incorporating discrim-

inator and generator functions [5, 11]. In ZSL-SBIR, a few

of the notable works include [11, 21, 5, 14]. These mod-

els have been experimented on the standard benchmarked

TU-Berlin and the Sketchy dataset and have shown to have

achieved the current state-of-the-art results.

How we are different? There exists only a handful

of works in SBIR. To the best of our knowledge, none of

them have been extended to a bi-directional retrieval frame-

work. Out of the few existing bidirectional-retrieval frame-

works, their performance on such minimalistic data repre-

sentation like sketch data remains unexplored. We design

a bi-directional retrieval framework, with zero-shot learn-

ing for image-sketch retrieval. While most of the works

in ZSL:SBIR use generative models by creating pseudo

samples of unseen classes using their semantic informa-

tion [5, 11], we have used a simple encoder-decoder strat-

egy for training. These kinds of generator and discrimina-

tor based models are usually not very stable and are hence

considered challenging to be trained. Most of the models

in literature use complicated high-level attributes derived

from multiple models for designing the semantic vector for

the unseen classes. We, on the other hand, use just the

word2vec word encoding of the label class and yet outper-



Figure 1. The Overall pipeline of the proposed ZSCMR architecture for a zero-shot retrieval from a cross-modal database, by projecting

the data samples on a shared semantic space. The network is trained on the seen classes and tested on unseen classes. H represents the

unified representation. With the help of the projection layer, retrieval from an unseen class is possible.

form all the current-state-of-the-art models for the same.

We introduce a novel cross-triplet loss here, which helps

primarily in boosting the CMR performance.

3. Methodology

Preliminaries: Let us denote two of the modalities cor-

responding to images and sketches as A and B, respec-

tively. The goal of the cross-modal retrieval setup is to

retrieve similar images in A/B given query images from

the other modality B/A. For a ZSL framework, we par-

tition the dataset into two subsets based on the classes,

namely, the seen and the unseen. Both the sets are hence-

forth represented by S = {As,Bs,Ys,Zs} and U =
{Au,Bu,Yu,Zu}, respectively, with the constraint that

(Ys ∩ Yu = ∅). Note that Ys defines the label-set

for the seen classes and Zs represents the semantic class

prototypes for the same (one prototype per class). Fur-

thermore, a given instance for (un)seen set is denotes as

(a
s/u
i , b

s/u
i , y

s/u
i , z

s/u
i ). As aforementioned, the model is

train only using S while U is only deployed during infer-

ence. Finally, our prime goal in zero-shot cross-modal re-

trieval is to design a mapping between the multi-modal vi-

sual space and the semantic space: (As, Bs) and Zs such

that given an aui ∈ Au and Zu, we can correctly retrieve

similar images from Bu and vice-versa.

We detail the proposed methodology in this section. A

depiction of the overall architecture of our model is illus-

trated in Figure 1.

3.1. Overall ZSCMR Architecture

To realize the ZSL framework on cross-modal data, we

use a two-stage training process, described as follows:

1. We first model the two modality-specific classifiers

given As and Bs, respectively. We fine-tune an Im-

agenet pre-trained CNN model for both the modalities

separately.

2. In the next stage, we introduce a multi-stream encoder-

decoder based neural network model on carrying out

the visual-semantic mapping task for ZSL based cross-

modal retrieval.

Stage 1: Since our ZSL based retrieval model con-

tains encoder branches corresponding to both the modali-

ties, we prefer to pre-train these modality-specific encoder

branches, which, in turn, offer better weight initialization

while training the ZSL model. Typically, we fine-tune the

pre-trained VGG and Resnet networks on (As,Ys) and



(Bs,Ys), respectively. The trained feature encoders in this

way are directly utilized in the ZSL network separately.

Stage 2: In the second stage, we aim to learn a shared latent

feature space H which ensures that the related data from As

and Bs with identical labels should be closely aligned with

the respective class prototype vectors from Zs in the latent

space. We propose a multi-stream encoder-decoder network

for this purpose. In the following, we detail the design

of this network. Broadly, the encoder part contains three

branches: i) two of the branches corresponding to the vi-

sual modalities A and B, respectively, while another branch

which encodes the semantic information Z .

a) Visual Encoders: For the visual data streams, we use en-

coders fA(; , θA) and fB(; , θB) to obtain the input features

corresponding to A and B respectively. θA and θB denote

the learnable parameters for both the encoder. Note that

both θA and θB are initialized in stage 1. Both the output

of the encoders yield feature embeddings with identical di-

mensionality so that they can be compared to subsequently

define the shared latent space.

b) Semantic Encoders:

Likewise, we also learn the semantic encoder fZ(; , θZ)
with the learnable parameter set θZ for embedding the se-

mantic information in Z . Initially, a given z ∈ Z is rep-

resented in terms of the distributed word-vector embedding

vectors corresponding to the semantic class names. Such

a semantic space like word2vec is semantics preserving,

e.g., the semantic topology is well-defined in such a repre-

sentation space ([17]).

The semantic encoder is defined as a series of fully-

connected layers to project the seen class prototypes Zs

onto the shared feature space.

c) Cross-Modal Decoders: We use decoder branches

gAB(; θAB) and gBA(; , θBA) which is aimed to reconstruct

the instances of A given the latent representations fB(B
s)

corresponding to modality B and vice-versa. We find that

the decoder module acts as a regularizer and helps in miti-

gating any domain difference between the multi-modal data

in the latent feature space.

3.2. Training

For stage 1, we fine-tune the pre-trained CNN mod-

els preferably with a lower learning rate on (As,Ys) and

(Bs,Ys) and fine-tune it for the dataset using a cross-

entropy loss, for obtaining the initialized fA() and fB(),
respectively.

For stage 2 training, we consider the following compo-

nent loss measures:

• Cross-Modal latent loss: (Lcmd).

• Cross-Modal Triplet loss: (L3tl).

• Decoder losses: (Lrcs).

• Classification loss: (Lclass).

We denote an instance of class c as (A/B)
s
c. For an instance

of any class other than c, we use the notation ˜(A/B̃)
s

c. These

losses and their contributions are individually explained in

the following.

Cross-modal latent loss (Lcmd): To reduce the discrep-

ancies between shared representations for a pair (asi , b
s
i )

having a common semantic representation zs, we seek to

reduce their mean-square error between the respective em-

beddings. In this light, we bring closer fA(a
s
i ) and fB(b

s
i ),

by reducing their distances from zs. This, in effect, reduces

the cross-modal intra-class variance substantially. In partic-

ular, this loss term is defined as follows:

Lcmd = ||fA(A
s
c)− fZ(Z

s
c )||

2

F
+||fB(B

s
c)− fZ(Z

s
c )||

2

F

(1)

F represents the Frobenious norm of a matrix.

Cross-modal triplet loss (L3lt): It is found that recon-

struction loss alone is not enough to yield good results. By

adding a triplet loss function, we can reduce the intra-class

distances, and increase the inter-class distances by pushing

the samples far apart in the embedding space. To incorpo-

rate the triplet loss in a cross-modal framework, we form

two types of triads. The first set of triads is constructed by

taking a sketch sample as an anchor, along with its corre-

sponding class image instance, and a different class image

instance. The second set of triads is constructed by taking

an image as the anchor, along with its corresponding sketch

instance from the same class and one sketch instance from

a different class. This function also acts as a regularizer

(shown in equation 2). Taking d() as the Euclidean distance

between two vectors, we define the loss function as (L3lt):

Lsi = max
(

d(fA (As
c) , fB (Bs

c))− d(fA (As
c) , fB

(

B̃s
c

)

) + α, 0
)

(2)

Lis = max
(

d(fB (Bs
c) , fA (As

c))− d(fB (Bs
c) , fA

(

Ãs
c

)

) + α, 0
)

(3)

L3lt = Lis + Lsi (4)

Decoder loss (Lrcs): We note that H should achieve

domain-independence by reducing any distributions-gap

between A and B. To enforce the domain-invariance, we en-

courage cross-domain sample reconstruction. In particular,

for a given (asi , b
s
i , l

s
i ), we aim for reconstructing bsi from

fA(a
s
i ) and vice-versa. Since the sketch and image data

drastically vary in appearance, such a cross-modal recon-

struction regularizer helps in better alignment of the cross-

modal data class-wise in H. The respective loss term is de-

fined as:

Lrcs = ||gAB(fA(A
s
c))− fB(B

s
c)||

2

F
+||gBA(fB(B

s
c))− fA(A

s
c)||

2

F

(5)



Classification loss (Lclass): To preserve the class informa-

tion in the shared space, we use a cross-entropy loss func-

tion and learn the network parameters. We use this to pre-

serve the class label information of As and Bs. Hence, the

classification loss is defined as:

Lclass = CE (fA(A
s)) + CE (fB(B

s)) (6)

Algorithm 1 The proposed training and inference stage

Input: S = {As,Bs,Ys,Zs}
Output: Unified representations H.

1: Stage 1: Normalize and pre-train As and Bs.

2: Stage 2: Find the Word2Vec embeddings of Ys.

3: Train the network to obtain H by optimizing L.

4: do

5:

min
θA,θB ,θAB ,θBA

Lcmd + L3lt + Lclass + Lrcs (7)

6: Train Z
7: while until convergence

8: return θA, θB , θAB , θBA (to realize H)

Input: aui ∈ Au or bui ∈ Bu and Zu

Output: Top-K retrieved data.

9: Cross-modal zero-shot retrieval using k-NN.

3.3. Overall Objective function ( L):

The final objective function is given by a linear com-

bination of sum of the above-mentioned losses (shown in

equation 8). Therefore, the overall objective function can

be represented as:

L = Lcmd + Lrcs + L3lt + Lclass (8)

Since we have multiple losses, our problem becomes a

non-convex optimization problem. To solve this, we reduce

each loss term individually, keeping the other losses con-

stant. The problem transforms into a convex optimization

problem for that loss. We use an iterative shrinkage-based

stochastic mini-batch gradient descent procedure to train

the framework. Once the mapping of the data instances is

made on the shared embedding space, the visual samples

become closer to their corresponding semantic vectors. Al-

gorithm 1 shows the overall approach for training the net-

work.

3.4. Cross­modal Retrieval

For the retrieval stage, once the network has been fully

trained, we save the trained network and save the weights

for unseen classes instances of both the modalities. Using

the feature embeddings of these instances, we choose a ran-

dom query sample and find the k-nearest neighbor distance

(Euclidean distance) from all other remaining samples. The

top-k retrieved images are considered as the retrieved re-

sults (shown in equation 9). This process is followed for

both the uni-modal and cross-modal retrieval. The D ma-

trix, as obtained from equation 3.4 is sorted to find the top-k
matches.

D = ||HA/Bu −HA/Bu(q)||2
2

(9)

Here q represents the query image. The idea is to design

such a robust shared embedding space that even a simple

l2-norm is enough for retrieval.

4. Experiments

In this section, we discuss in detail the training and the

experimental protocols that have been used.

Datasets: We perform our experiments on two standard

benchmark SBIR datasets, namely the Sketchy [20] and the

TU-Berlin [13] dataset.

The Sketchy dataset [20] is a large scale dataset of

sketch-photo pairs. Each photo consists of multiple cor-

responding sketches. There are 125 classes. Each class

consists of 100 photos, and a variable number of sketches.

Therefore the total number of photos is 12,500, while the

number of sketches is 75,471. For our experiments, we

choose randomly 25 classes for the testing phase as the un-

seen classes (U ). The remaining 100 classes were used for

the training phase as the seen classes (S).

The TU-Berlin dataset [13] consists of 250 classes, with

20,000 sketches and 204,489 photos. We train the network

on 220 classes and test the results from the remaining 30

classes.

Model Architecture: To pre-train the network to get suffi-

ciently discriminative initialization weights, we use a pre-

trained ResNet50 and a VGG-16 based transfer-learning

from the sketch and the image data. The network was fine-

tuned to enhance its effectiveness on our dataset. We get

a resultant feature vector of size 2048-d. The network was

trained using a momentum optimizer, and a learning rate

of 0.001 was chosen. To design the second stage, we ex-

tract the 300-d Word2Vec embedding of the labels of the

datasets.

In the encoder part, we have kept three layers of fully-

connected layer for fA() and fB(). Similarly, for the de-

coder part, we have used a single fully-connected layer af-

ter the last layer of the encoders for fAB() and fBA(). We

have also added a batch normalization layer and induced a

non-linearity function at the output of every fully-connected

layer using ReLU(). For our experiments, we chose a learn-

ing rate of 0.001 and optimized the loss function using the

Adam optimizer with a stochastic mini-batch gradient de-



Table 1: Performance of the proposed ZSCMR framework on the Sketchy and TU-Berlin dataset in terms of mAP and

precision at top-100 (P@100) values and their corresponding embedding vector dimensions (Sketch→Image).
Task Sketchy TU-Berlin size

mAP P@100 MAP P@100

Siamese CNN [18] 0.183 0.143 0.153 0.122 64

SaN [26] 0.129 0.104 0.112 0.096 512

3D Shape [24] 0.070 0.062 0.063 0.057 64

DSH (Binary) [13] 0.171 0.231 0.129 0.189 64

SBIR GDH (Binary) [27] 0.187 0.295 0.135 0.212 64

GN Triplet [20] 0.204 0.296 0.175 0.253 1024

SSE [28] 0.154 0.108 0.133 0.096 100

JLSE [29] 0.131 0.185 0.109 0.155 220

ZSL ZSH [25] 0.159 0.214 0.141 0.177 64

SAE [12] 0.216 0.293 0.167 0.221 300

ZS-SBIR [11] 0.196 0.284 0.005 0.001 1024

ZSL:SBIR ZSIH (Binary) [21] 0.258 0.342 0.223 0.294 64

EMS [15] - - 0.259 0.369 512

EMS (Binary) [15] - - 0.165 0.252 64

CAAE [11] 0.196 0.284 - - 4096

CVAE [11] 0.225 0.333 - - 4096

SEM-PCYC [5] 0.349 0.463 0.297 0.426 64

SAKE [14] 0.364 0.487 0.359 0.481 64

ZSCMR 0.467 0.510 0.362 0.429 64

Table 2: Performance of the proposed ZSCMR framework

on the Sketchy and TU-Berlin datasets in terms of mAP and

precision at top-100 (P@100) values.

Task Sketchy TU-Berlin

mAP P@100 MAP P@100

Sketch→Image 0.467 0.510 0.362 0.429

Image→Sketch 0.429 0.451 0.298 0.353

Sketch→Sketch 0.444 0.559 0.318 0.397

Image→Image 0.686 0.718 0.605 0.653

scent approach. We trained the model with a batch size

of 128, for 40 epochs. The α value of the triplet loss was

heuristically set to 1.

Training and Evaluation Protocol: This network is then

followed by a series of three fully connected networks,

responsible for obtaining the shared embedding space for

all the three the modalities of data. The triplets were se-

lected by taking random anchor images from the training

dataset and taking the same class and a different class sam-

ple from the other modality. The number of anchors from

each modality were kept the same (10,000 triplets each).

For the evaluation of our results, we use the standard mAP

(mean average precision) and P@100 (precision for top-

100) scores. Also, we compare the performance of our

method on the Sketchy and the TU-Berlin dataset to the

state-of-the-art algorithm [5]. A few more comparisons

have been shown with [13, 27, 20, 29, 25, 12, 11, 21, 14].

Figure 2. Top retrieved results of zero-shot cross-modal retrieval.

Alternate rows represent Sketch→Image and Image→Sketch re-

trievals.

5. Results and Discussions

The train and test classes were chosen randomly for the

experiments to avoid any bias induced while training. We

report the performance of our model for both cross-modal

and uni-modal retrieval in table 2.

Table 1 shows our and the other state-of-the-art model.

The comparative study has been divided into three sub-

parts. The first part shows the retrieval results using a sim-

ple SBIR framework, and the second part shows the results

using ZSL, and the third set shows the algorithms which



have both ZSL and an SBIR framework. It can be seen that

not only our framework beats state-of-the-art results with a

high margin, it is also simultaneously capable of encoding

the cross-modal and uni-modal neighborhood knowledge.

Fig. 2 shows the top retrieved images, given a query image

(first column). The images with green boundaries represent

the correctly retrieved classes, while the red ones represent

the incorrectly retrieved images.

5.1. Ablation Studies

To investigate the contribution of each of the losses in

our system, we perform an ablation study wherein we train

the network, excluding one loss at a time. This helps us to

understand the contribution of each loss in the proposed net-

work. We perform the ablation studies for both the Sketchy

and the TU Berlin datasets and compare their correspond-

ing SBIR and Image-based sketch retrieval (IBSR) perfor-

mances. Figure 3 shows the bar graph of the performance

of each of these studies in terms of mAP values.

For the first set of experiments, we keep all losses as

given in the objective function in equation 8. The results

obtained from this has been reported and explained in the

previous sections. Next, we trained the model using equa-

tion 8, leaving the cross-modal latent loss. The performance

falls drastically as the feature embedding of both the modal-

ities fall quite apart from each other.

For the third set of experiments, we omit the cross-

entropy classifier loss from the overall objective function.

As seen from figure 3, the performance of the model drops

even more, as, in this case, the class information embed-

ding in the shared space is lost. The shared latent space is

no longer sufficiently discriminative, and there is a consid-

erable reduction in the intra-class distances.

For the next set of experiments, we drop the cross-triplet

loss function from the total loss equation. We can see a rise

in the performance of the model as compared to the previ-

ous experiments. This loss helps in bringing down the inter-

modal distances while pushing the samples from the same

classes further apart in the feature space. Finally, we look

at the effect of the network without the decoder loss func-

tion. This provides an immense boost in the performance of

the model in combination with the triplet loss. It helps the

network achieve domain Independence. The exact effect is

illustrated in figure 3.

It can be seen from the bar graphs that while the triplet

loss and decoder losses help in beating the state-of-the-art

results, the cross-latent loss and the cross-entropy losses are

the essential loss functions without which the performance

of the network fails miserably.

6. Conclusion

We propose a cross-modal zero-shot retrieval framework

and evaluate the results on sketch-based data. The imple-

Figure 3. Ablation study of each of the loss terms in the Sketchy

and the TU-Berlin dataset. The bar-graph shows both sketch-based

image retrieval and image-based sketch retrieval performances, in

terms of mAP values.

mentation of our project can be found from the GitHub link:

https://github.com/ushasi/A-Simplified-

framework-for-Zero-shot-Cross-Modal-

Sketch-Data-Retrieval. The main motive of our

problem statement is to project different domain data

onto a common embedding space, wherein discrimination

between different classes within different data can be

effectively possible. The proposed framework not only

beats the current state-of-the-art results in unseen classes

SBIR, but it also successfully encodes the image-based

sketch retrieval, as well as the two uni-modal retrieval

data information in the unseen classes. This has been

made possible by making different classes separable in the

semantic space. We are currently interested in exploring

further in this domain and investigating the results with

incremental learning.
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